
Versuch
Hohlraumresonatoren

Tiefere Einsichten in das Phänomen physikalischer
Resonanzen

Fortgeschrittenenpraktikum im Studiengang Physik

Universität Hamburg

Wolfgang Hillert, Velizar Miltchev



Inhaltsverzeichnis

1 Theoretische Grundlagen 2
1.1 Hohlraumresonatoren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.2 Das Cavity als Schwingkreis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
1.3 Der komplexe Reflexionsfaktor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
1.4 Messung von |ρ| . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
1.5 Vektorielle Messung des Reflexionsfaktors . . . . . . . . . . . . . . . . . . . . . . . . . 21
1.6 Störkörpermessungen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
1.7 Feldplots einiger Resonatormoden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

2 Versuchsdurchführung 42
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1 Theoretische Grundlagen

1.1 Hohlraumresonatoren
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1. Hohlraumresonatoren 

Wir leiten die Eigenschwingungen (resonanten Moden) eines Hohlraumresona-

tors aus den Maxwellschen Gleichungen ab. Dazu behandeln wir zunächst die 

Wellenausbreitung in zylindrischen Hohlleitern und führen die unterschiedli-

chen Ausbreitungsformen von Wellen (Hohlleitermoden) ein. Der Übergang zu 

zylindrischen Hohlraumresonatoren gelingt danach durch ein Verschließen des 

Hohlleiters durch leitende Wände, wodurch in longitudinaler Richtung zusätzli-

che Randbedingungen entstehen und stehende Wellen auftreten. 

Wellenausbreitung und Maxwellsche Gleichungen  

Startpunkt sind die Maxwellschen Gleichungen in differentieller Form, die sich 

für Vakuum (hier sind keine Ladungsträger vorhanden!) mit Hilfe von 0ε  und 

0μ  durch die E- und H-Felder ausdrücken lassen: 
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Bilden wir nun die Rotation der ersten (bzw. der dritten) Gleichung, ersetzen 

den Ausdruck H
t

∂
∇ ×

∂

GG
 (bzw. E

t
∂

∇ ×
∂

GG
) durch die zeitliche Ableitung der dritten 

(bzw. der ersten) Gleichung und nutzen die Operatoridentität 

( ) ( )a a∇ × ∇ × = ∇ ∇ − Δ
G G G G

aG G Gi , 

so erhalten wir unter Ausnützung der Divergenzbeziehungen (Maxwell-Glei-

chung zwei bzw. vier) die Differentialgleichungen des elektrischen und magne-

tischen Felds für eine Wellenausbreitung im Vakuum: 
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2

0 0

2

2 2

2

2 2

1
1 ( , )( , ) 0
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Betrachten wir ausschließlich Wellen einer bestimmten Frequenz ω , können wir 

die Zeitabhängigkeit explizit durch 

( , ) ( ) , ( , ) ( )i t i tE r t E r e H r t H r eω ω= ⋅ = ⋅
G G G GG G G G  

ausdrücken und die Wellengleichung durch Einsetzen vereinfachen: 

2

2

2

2

( ) ( ) 0

( ) ( ) 0

c
E r E r

H r H r

ω

ω

Δ + =

Δ + =

G G

c

G G

G GG G
 

Hohlleiter  

Wir beginnen mit der Betrachtung allgemeiner, in z-Richtung ausgerichteter 

Hohlleiter, die damit auch die Wellenausbreitung auf die z-Richtung festlegen. 

Mit dem Ansatz ( )( , ) i t kzE E x y e ω −= ⋅
G G

 und der Aufteilung 
2

2z⊥
∂Δ = Δ +
∂

 ergibt sich 

für die longitudinalen Felder: 

2
2 2

2 ck k
c
ω

− =
2

2

0
mit

0
(Dispersionsrelation des Hohlleiters)

z c z

z c z

E k E
H k H

⊥

⊥

=
Δ
Δ +

+ =  

 

Die Größe  wird auch als kritische Wellenzahl bezeichnet und ist eine Kenn-

größe des Hohlleiters – wie wir im Folgenden noch sehen werden. 

ck

Zur Berechnung der transversalen Felder nutzen wir die erste (bzw. dritte) 

Maxwellsche Gleichung. Es wird sich herausstellen, dass eine Kenntnis der 

longitudinalen Felder zE  und zH  ausreicht und die zugehörigen transversa-

len Felder E⊥

G
 und H⊥

G
 aus den longitudinalen berechnet werden können. So 

erhalten wir z. B. für das E-Feld 
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Kombinieren wir diese zwei Gleichungen, ergibt sich 

( ) ( ) ˆz zE ikE E e⊥ ⊥⊥
∇× = +∇ ×
G G G G

 

und völlig analog  ( ) ( ) ˆz zH ikH H e⊥ ⊥⊥
∇× = + ∇ ×
G G G G

. 

Aus der ersten und dritten Maxwellschen Gleichung erhalten wir 

( )
( )

0 0

00

ˆ ˆ
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ˆˆ

z z z z

z zz z

ikE E e i H ikE E i H e
ikH H i E eikH H e i E
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+ ∇ = − ×+ ∇ × =

G G G G G G
G G GG G G  

was sich nach etwas Rechnen (Einsetzen über Kreuz) zu folgenden Beziehungen 

umwandeln lässt: 
2

0
2

0

ˆ
ˆ

c z z z

c z z z

ik E k E H e
ik H k H E e

ωμ

ωε
⊥ ⊥ ⊥

⊥ ⊥ ⊥

+

−

= ∇ ∇ ×
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Wir können die verschiedenen möglichen Wellen wie folgt klassifizieren: 

a) Fall : 

Phasengeschwindigkeit aus der Dispersionsrelation: 

2 0ck =

v ph c
k
ω

= =  

Impedanz über E
H

ζ = , damit ˆz z z

5

E H eζ⊥ ⊥∇
G

= − ⋅∇ ×
G

: 0

0

μζ =

z

zH

ε
 

1.) : HE oder EH Hybrid-Wellen (werden zur 

 Ablenkung geladener Teilchen in RF Separatoren benutzt) 

2.) 

0, 0zE H⊥ ⊥∇ ≠ ∇ ≠
G G

0 and 0zE⊥ ⊥= =∇ ∇
G G

: transversale TEM Wellen 

b) Fall : 

Keine Ausbreitung  für 

2 0ck ≠

: evaneszente Wellen ↔ “cut-off” cc kω ≤ ⋅
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Phasengeschwindigkeit aus Dispersionsrelation: 
2

2v 1 c
ph

kc c
k

= ⋅ + >  

Die Impedanz hängt von der Ausbreitungsmode ab: 

1.) Ez = 0: TE (transversal elektrische) oder H (weil Hz ≠ 0) Wellen 

 Impedanz über 0 ˆzikE i H eωμ⊥ ⊥= − ×
G G

:  0 0
E
H

Z
k
ωμ⊥

⊥

==  

2.) Hz = 0: TM (transversal magnetische) oder E (weil Ez ≠ 0) Wellen 

 Impedanz über  ( )0ˆzikH e i Eωε σ⊥ ⊥× = +
G G

: 0
0

kZ
ωε

=  

Verbunden mit der kritischen Wellenzahl ist eine kritische Frequenz c ck cω = ⋅ , 

unterhalb derer keine Wellenausbreitung im Hohlleiter stattfindet. Die Dispersi-

on im Hohlleiter weicht daher von der im Vakuum oder einem Koaxialkabel 

(TEM-Wellen) für kleine Frequenzen deutlich ab: 

 
Betrachten wir nun im Folgenden zylindrische Hohlleiter mit Innenradius a: 

 

6

coA

CDc
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Die longitudinalen Felder müssen die Wellengleichung lösen: 
2
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Separation des ϕ -abhängigen Anteils 

( , ) ( ) ( ), ( , ) ( ) ( )z zE E H HE r R r H r R rϕ θ ϕ ϕ θ ϕ= ⋅ = ⋅  

2

2

2 2
2 2 2

2
1

c
r d R r dR dk r m
R R dr ddr

θ
θ ϕ

⇒ ⋅ + + = − =  

ergibt zwei Differentialgleichungen für die Anteile der longitudinalen Kompo-

nente und als Lösung die trigonometrischen Funktionen für den Winkelanteil 

und die Bessel- bzw. Neumannfunktion für den radialen Anteil: 

( ) ( )

2
2

2

2 2
2

2 2

0
( ) cos sin
( ) ( ) ( )1 0 m c m c
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m m

d m
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Mit 1ˆ ˆre e
r rϕ ϕ⊥

∂∇ = +
∂

G ∂
∂

 erhalten wir für die transversalen Felder: 

2
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⎧ ⎫ ⎧ ⎫∂ ∂ ∂ ∂
= + −⎨ ⎬ ⎨ ⎬∂ ∂ ∂ ∂⎩ ⎭ ⎩ ⎭

G
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Die möglichen Feldverteilungen werden durch die Randbedingungen an den 

Wänden des Hohlleiters weiter eingeschränkt: 

• 0; 0 fürzE Eϕ = = =r a    (verschwindende Tangentialkomponenten) 

• 0 fürrH r a= =    (verschwindende Normalkomponenten) 

76



 

Erläuterung der Messmethoden  W. Hillert 

Hiermit wird einem folgender Ansatz für das magnetische (im Fall der TE-

Moden) bzw. das elektrische Feld (im Fall der TM-Moden) nahegelegt: 
 

TE- oder H-Wellen mit Ez = 0: 

(( ) cosz mn m c )H H J k r mϕ= ⋅ ⋅ ⋅ , wobei ( ) 0ḿ cJ k a =  gelten muss und  n angibt, 

um welche Nullstelle  es sich dabei handelt. Mit '
mnj 1,2,3,...n =  und  

gilt näherungsweise folgende Dispersionsrelation für TE-Wellen: 

0,1,2,...m =

( )
22 222 2 2

2
2 3 4wobei

4 4c c
m mk k k a n

c
ω π⎛ ⎞

⎜ ⎟
⎝ ⎠

3− ++ = ≈ + −  

 
Wir erhalten damit für die transversalen Felder der TE-Wellen: 

( ) ( ) ( ) ( )

( ) ( ) ( ) ( )

0

0

sin ´ cos

´ cos sin

r m c mn r m c
c c c

m c mn m c mn
c c c

m kE i J k r m H H i J k r m H
k k r k

k m

mn

E i J k r m H H i J k r m H
k k k rϕ ϕ

ωμ ϕ

ωμ ϕ

= ⋅ ⋅ = − ⋅ ⋅

= ⋅ = ⋅ ⋅

ϕ

ϕ
 

 

Die Mode mit der kleinsten Frequenz (Fundamentalmode) ist die TE11 mit m>0, 

was durch die Forderung verschwindender Normalkomponenten von H bedingt 

ist! Allgemein gilt für die Cut-Off-Frequenzen ′= ⋅mn mnj c aω . 
 

TM- oder E-Wellen mit Hz = 0: 

(( ) cosz mn m c )E E J k r mϕ= ⋅ ⋅ ⋅ , wobei ( ) 0m cJ k a =  gelten muss und n angibt, um 

welche Nullstelle jmn es sich dabei handelt. Mit 1,2,3,...n =  und  0,1,2,...m =

gilt Näherungsweise folgende Dispersionsrelation für TM-Wellen: 

( )
22 222 2 2

2
12 1 4mit

4 4
⎛ ⎞ −
⎜ ⎟
⎝ ⎠

−+ = ≈ + −c c
m mk k k a n

c
ω π  

 

Wir erhalten damit für die transversalen Felder der TM-Wellen: 

( ) ( ) ( ) ( )

( ) ( ) ( ) ( )

0

0

´ cos sin

sin ´ cos

r m c mn r m c
c c c

m c mn m c mn
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Die Fundamentalmode ist die TM01 mit m=0 und n=1, 0rE Hϕ = = : 

 
Die TM01 wird in Linearbeschleunigern und Beschleunigungsresonatoren zur 

Beschleunigung geladener ultrarelativistischer Teilchen verwendet. 

Für die Cut-Off-Frequenzen gilt: mn mnj c aω = ⋅  

Eigenmoden zylindrischer Resonatoren  

Fügen wir in den Hohlleiter eine senkrecht zur z-Richtung stehende leitende 

Platte ein, wird die einlaufende Welle vollständig reflektiert und wir erhalten 

eine stehende Welle. Dies ändert die Abhängigkeit der Felder in z-Richtung: 

( )0sinikza e A kz ϕ⋅ → ⋅ +  

An den Knotenebenen können daher ohne Veränderung der Feldverteilung lei-

tende Platten eingefügt werden. Dies führt zu einem zylindrischen Hohlraumre-

sonator, bestehend aus einem Hohlleiter der Länge l, der an seinen beiden Enden 

durch leitende Platten verschlossen ist. Für die longitudinalen Randbedingungen 

ist daher k p lπ= ⋅  zu fordern. Mit den o. a. Hohlleiter-Eigenmoden ergeben 

sich damit folgende longitudinale Felder: 

TEmnp-Moden: ( ) ( ) ( )cos sin mnpi t
z mn m cH H J k r m p l z e ωϕ π= ⋅ ⋅ ⋅ ⋅ ⋅  

TMmnp-Moden: ( ) ( ) ( )cos cos mnpi t
z mn m cE E J k r m p l z e ωϕ π= ⋅ ⋅ ⋅ ⋅ ⋅  

Für die Resonanzfrequenzen gilt: ( ) ( )
2 2(')= ⋅ +m n p m nc j a p lω π  
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Stellt man die Formel für die Resonanzfrequenzen ein wenig um, so erhält man 

die folgende Geradengleichung, wobei  die jeweilige Nullstelle der Bessel-

funktion bzw. ihrer Ableitung bezeichnet: 

)('
mnj

2 2 2(')
2 2mncj c d(d ) p

2 l
⎛ ⎞ ⎛ ⎞ ⎛ ⎞ν = + ⎜ ⎟ ⎜ ⎟⎜ ⎟π ⎝ ⎠ ⎝ ⎠⎝ ⎠

 
 

Dabei wurde der Durchmesser ad ⋅= 2  des Resonators eingeführt. Trägt man 

die Geraden der verschiedenen Moden in ein Diagramm ein, so erhält man eine 

sogenannte Modenkarte (hier für 2≤p ):   

 

1e+17

2e+17

3e+17

4e+17

5e+17

6e+17

0 2 4 6 8 10 12 14 16

TM110

TM010

TM210

TM020
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TE21

(d/l)
2

(
d
)

/
s

m
�

2
-2

2

TM11

TE01

TE31

TM21

TE12
TE41

TM02

TM31

TE51

TE22

TE02
TM12

TE61

TM41

TE32

[

[

TM310

TM120

TM410

TE 111

TM 011

TE 211

TM 111
/ TE 011TE 311

TM 211

TE 411
TE 121

TM 021
TM 311

TE 511

TE 611

TM 121
/ TE 021

TM 311TE 321

p=2

TE 221

 
 

Aus ihr lässt sich die Anordnung der verschiedenen Moden eines Resonators für 

ein gegebenes Verhältnis von Durchmesser zu Länge ablesen. Aus den Ordina-

tenwerten lassen sich deren Frequenzen bestimmen. 
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Die zur expliziten Berechnung der Resonanzfrequenzen erforderlichen Nullstel-

len der Besselfunktionen bzw. deren jeweiliger erster Ableitung finden sich in 

den folgenden beiden Tabellen: 
 

Nullstellen von Jm(x): 
n j0n j1n j2n j3n j4n j5n

 - 0 0 0 0 0 
1 2,40482 3,83171 5,13562 6,38016 7,58834 8,77148 
2 5,52007 7,01559 8,41724 9,76102 11,06471 12,33860 
3 8,65372 10,17347 11,61984 13,01520 14,37254 15,70017 
4 11,79153 13,32369 14,79595 16,22347 17,61597 18,98013 
5 14,93091 16,47063 17,95982 19,40942 20,82693 22,21780 

       
       
Nullstellen von J’m(x): 
n j'0n j'1n j'2n j'3n j'4n j'5n

 0 - 0 0 0 0 
1 3,83170 1,84118 3,05424 4,20119 5,31755 6,41562 
2 7,01558 5,33144 6,70613 8,01524 9,28240 10,51986 
3 10,17346 8,53632 9,96947 11,34592 12,68191 13,98719 
4 13,32369 11,70600 13,17037 14,58585 15,96411 17,31284 
5 16,47063 14,86359 16,34752 17,78875 19,19603 20,57551 

 

 

Die jeweils niedrigste Nullstelle (außer der trivialen) ist farblich markiert, aus 

ihr berechnet sich die jeweilige Fundamentalmode der beiden Modenklassen.  

Die Gleichheit der Nullstellen j'0n und  j1n deutet darauf hin, dass die Ableitung 

der Besselfunktion nullter Ordnung mit der Besselfunktion erster Ordnung über-

einstimmt: 

)()( 10 xJxJ
dx
d

= . 

Die entsprechenden TE- bzw. TM-Moden weisen daher die gleiche Resonanz-

frequenz auf:  

TE0np = TM1np  für beliebige Werte von n und p. 
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Die folgenden Abbildungen zeigen eine Momentaufnahme der Feldverteilungen 

der ersten beiden TM-Moden eines abgeschlossenen, zylindrischen Resonators, 

weitere Beispiele finden sich im Anhang. Wegen  p = 0  besteht bei beiden Mo-

den keine Abhängigkeit von der Resonatorlänge, das elektrische Feld hat damit 

nur eine longitudinale Komponente. Für die Abbildung wurde der Resonator 

jenseits einer willkürlich gewählten Schnittebene transparent dargestellt. 
 

TM010-Mode
 

  
  

  
  
  
  

  
  
  
  
  

( )E r
G G

 ( )H r
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2. Das Cavity als Schwingkreis 

Definition der Kenngrößen im unbelasteten Fall  

Wir betrachten das Ersatzschaltbild eines Hohlraumresonators – den LCR-

Parallelkreis: 

 
Es gelten die bestens bekannten Beziehungen: 

13

Spannungen:  C RU U UL− = = ,       CC U I⋅ =� ,       LU L I= ⋅ �  (Generator!) 

Ströme:       C R LI I I= +  

Dies ergibt die Differentialgleichung 

1 1 0U U U
RC LC

+ + =�� �  

 

Wir definieren folgende Größen: 

• Zeitkonstante   R Cτ = ⋅  

• Resonanz-Kreisfrequenz  0
1

L C
ω =

⋅
 

• Kreisgüte 0
0

2 gespeicherte Energie 2
Energieverlust pro Periode

W WQ
T P P

π π ω⋅ ⋅ ⋅
= = =

⋅
 

Als Lösung ergibt sich für einen schwach gedämpften Kreis (Schwingfall) 

( ) ( )0 02 t
t

iU t U e e0
ω ϕτ +−

= ⋅ ⋅  

 

Für die gespeicherte Energie ergibt sich  
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2 2
0

1 1
2 2

t
W C U C Ue τ−

= ⋅ = ⋅ ⋅ ⋅ , 

der Energieverlust (dissipierte Leistung) beträgt 

1P W W
τ

= = − ⋅�  

und damit erhalten wir für die Kreisgüte die altbekannten Beziehungen 

0
0 0 0

⋅
= = ⋅ = =

W RQ R
P L0

Cω ω τ ω
ω

 

 

Erzwungene Schwingungen  

Wir regen den Schwingkreis mit einer externen Stromquelle an und erhalten 

 

Spannungen:     C RU U UL− = =  

Ströme:      C ext R LI I I I+ = +  

C C CI Q C U= = ⋅� �  
R RI U R=  

L LI U L=�  

20
0

1
extU U U

Q C0

Iω ω+ ⋅ + ⋅ =�� � �  

 

Wir setzen für die externe Anregung ˆ i t
ext extI I e ω= ⋅  und erhalten mit dem Ansatz 

ˆ i tU U e ω= ⋅ die inhomogene komplexe Lösung: 

 
2 2 0

0
0

ˆ
ˆ

exti I
CU i

Q

ω

ωωω ω
=

− +
 

Nach Einsetzen der Beziehung für die Kreisgüte ergibt sich folgendes wohlbe-

kanntes Resultat: 
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0

0 00
0

ˆ ˆˆ
1 21

ext extR I R IU
iQiQ

ω ω

ωω ω
ωω ω

Δ⋅ ⋅
= ≈

Δ⎛ ⎞ ++ −⎜ ⎟
⎝ ⎠

�
 

 

woraus sich für Betrag und Phasenverschiebung Folgendes ergibt: 

0

2 2
22 0

00
0

ˆ ˆˆ

1 41

ext extR I R IU

QQ

ω ω

ωω ω
ωω ω

Δ⋅ ⋅
= ≈

⎛ ⎞ ⎛ ⎞Δ++ −⎜ ⎟ ⎜ ⎟
⎝ ⎠⎝ ⎠

�
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0
0

0 0
0

tan 2Q Q
ω ωω ω ωϕ

ω ω ω

Δ⎛ ⎞ Δ
= − ≈ −⎜ ⎟

⎝ ⎠

�

 

 

Die Abhängigkeit der Spannung von der Frequenz wird durch die Resonanzkur-

ve dargestellt und hat folgende Form (ideale Spule 0rω ω⇒ = !) 

 
Die unbelastete Kreisgüte kann auf einfache Weise durch Messung der so ge-

nannten Halbwertsbreite HωΔ aus der Resonanzkurve bestimmt werden (was 

durch Einsetzen in die Beziehung für Û  einfach verifiziert werden kann): 

0
0

H

Q ω
ω

=
Δ

,  HωΔ = volle Halbwertsbreite bei max

2
U  
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Der Phasenverlauf zeigt einen Nulldurchgang der relativen Phase bei 0ω  

 

Belasteter Fall durch Einkopplung von Hochfrequenz  

Es gibt im Wesentlichen drei verschiedene Möglichkeiten, Hochfrequenz in ei-

nen Hohlraumresonator einzukoppeln: 

• Kopplung an das magnetische Feld (Schleifenkopplung) 

• Kopplung an das elektrische Feld (Stiftkopplung) 

• Einkopplung aus dem Hohlleiter (Schlitzkopplung) 
 

Wir wollen uns im Folgenden auf eine magnetische Einkopplung beschränken, 

die anderen Einkopplungen können völlig analog behandelt werden. Im Fall der 

Schleifenkopplung ergibt sich folgendes Szenario im Ersatzschaltbild: 
 

 
 

Ziel der Einkopplung ist es, die vom Generator erzeugten Mikrowellen mög-

lichst vollständig (d.h. relexionsfrei) in den Resonator zu bringen. Dazu muss 

die Leitung vom Generator zum Resonator mit ihrem Wellenwiderstand (Impe-
1615
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danz typ. 50Ω) abgeschlossen werden. Die Impedanz des Resonators ist eine 

komplexe Größe und nur im Resonanzfall reell. Sie wird dann als so genannte 

Shuntimpedanz SR bezeichnet: 

( )0 reellSZ Rω = =  

Die Größenordnung beträgt typischerweise MΩ! Daher wird sie durch die 

Schleifenkopplung zu 2
a SZ R n= herab transformiert; im Ersatzschaltbild ent-

spricht dies einem Transformator mit Wicklungsverhältnis n. Für die Reflexion 

ist das Verhältnis aus Abschlusswiderstand und Leitungsimpedanz maßgebend. 

Wir definieren daher als Koppelfaktor 

2
0 0

a SZ R
Z n Z

κ = =
⋅

 

Der Resonator wird durch die externe Leitung zusätzlich belastet: 

2

1 1 1 1 1 1

0 0 extSR R n Z Q Q Q
= + ⇒ = +

⋅
 

 

und die unbelastete Kreisgüte sinkt durch das zusätzliche Auftreten einer exter-

nen Güte  auf den Wert Q. Formal erhalten wir durch Einbeziehung der ex-

ternen Verlustleistung  folgende Zusammenhänge: 

extQ

extP

0 0
ext

W WQ Q
P Pext extP

ω ω⋅ ⋅
= ⇒ =

+
 

0
2

0

ext S

ext

Q P R
Q P n

κ = = =
Z⋅

 

 

Wir unterscheiden die 3 Fälle 

• :  unterkritische Kopplung, 1κ < 0 2Q Q>  

• :  kritische Kopplung,  1κ = 0 2Q Q= ,   keine Reflexion! 

• :  überkritische Kopplung, 1κ > 0 2Q Q<  
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1.3 Der komplexe Reflexionsfaktor
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Bei Kenntnis des Koppelfaktors kann die unbelastete Güte  aus der gemesse-

nen belasteten Güte  errechnet werden: 

0Q

Q

( )0 1Q Qκ= + ⋅  

 

Der komplexe Reflexionsfaktor 

Abhängigkeit vom Leitungsabschluss  

Im Fall einer Reflexion haben wir eine hinlaufende (Û+ , Î+ ) und eine rücklau-

fende ( , Û− Î− ) Welle auf der Leitung. Wir definieren den komplexen Reflexi-

onsfaktor ρ  durch das Verhältnis 

ˆ
ˆ

U
U

ρ −

+

=  

Am Abschlusswiderstand aZ  und der Leitungsimpedanz 0Z  haben wir dann 

ˆ ˆ ˆ
ˆ ˆ ˆa

U U UZ
I I I

+ −

+ −

+
= =

+
, 0

ˆ ˆ
ˆ ˆ

U UZ
I I

+ −

+ −

= =
−

 

und erhalten nach Einsetzen des Reflexionsfaktors 0ρ  am Leitungsende 

( )
( )

00 0
0 0

11
1

aa
a

Z ZZ ZZ Z
Z Z Z Z

ρ ρ
ρ

−+ −
= ⋅ ⇔ = =

0 0 0 1a a− + +
 

 

Reflexion in der Nähe einer isolierten Resonanz  

Im Fall nicht überlappender Resonanzen (den wir hier ausschließlich betrachten 

wollen) ist uns die Impedanz des Resonators bekannt (vgl. Kapitel 2.2.). Wir 

erhalten mit 
0

Cav
0 00

0

1 21

S SR RZ
iQiQ

ω ω

ωω ω
ωω ω

Δ

= ≈
Δ⎛ ⎞ ++ −⎜ ⎟

⎝ ⎠

�
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und unter Einbeziehung des Koppelfaktors 

0

2
0 0

01 2
a Cav Cav

S

Z Z Z
Z n Z R iQ

ω ω κ
κ ω

ω

Δ
= = ≈

Δ⋅ +

�
 

Damit ergibt sich für den komplexen Reflexionsfaktor in Abhängigkeit der Fre-

quenzverschiebung ωΔ  von der Resonanzfrequenz 0ω : 

( )
( )
( )

0

0

0

1 2

1 2

iQ

iQ

ωκ ωρ ω
ωκ ω

Δ− +
Δ =

Δ+ +
 

 

Dies gilt natürlich nur unmittelbar an der Resonatoreinkopplung. Wird der Re-

flexionsfaktor in einer Entfernung l von der Einkopplung (bedingt durch das 

Verbindungskabel zwischen Messbrücke und Resonatoreinkopplung) gemessen, 

addiert sich der doppelte Laufzeitfaktor der Welle im Kabel. Mit der Wellenzahl 

´ ´
v ph

k L Cω ω= = ⋅ ⋅ , 

die von den Kabeleigenschaften (Induktivität L’ bzw. Kapazität C’ pro Länge) 

und von der Frequenz (!) abhängt, ergibt sich unter Vernachlässigung der Lei-

tungsverluste (aufpassen bei Hohlleitern, da ist das Ganze abhängig von der an-

geregten Mode!) 

( ) ( )
( )
( )

0

0

0

2 2
1 2

1 2
ikl ikl

iQ

iQ
e e

ωκ ωρ ω ρ ω
ωκ ω

− −
Δ− +

Δ = Δ ⋅ = ⋅
Δ+ +

 

In Anbetracht der großen Kreisgüten ( 0 1000 10000Q = − ) wollen wir aber die-
sen Effekt im Folgenden erst einmal vernachlässigen – er ist jedoch bei größe-
rem Frequenzhub sehr schön auf dem nicht kalibrierten Netzwerkanalysator 
 bei der vektoriellen Messung des Reflexionsfaktors zu beobachten und führt 
zu Kreisen mit annähernd konstantem Radius, die in der Auswertung zur
Normierung herangezogen werden. 
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1.4 Messung von |ρ|
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4. Messung von |ρ| 

Die „Resonanzkurve“  

Durch Aufspaltung in Real- und Imaginärteil erhalten wir für den komplexen 

Reflexionsfaktor am Ort der Einkopplung 

( )
( ) ( )

( ) ( )0 22

04i Q

0

2
2 2

0

21

1 4

4Q

Q ω
ρ ω

ωκ

ω κ ωκ ω

ω

−
Δ =

Δ+ +

− − Δ Δ
 

und nach Bildung des Betrages ergibt sich 

( ) ( )
( ) ( )
( ) ( )

22 2
0

0 22 2
0

1 4

1 4

Q

Q

ωκ ωρ ω ρ ω
ωκ ω

Δ− +
Δ = Δ =

Δ+ +
 

 

Auf einem Skalaren Netzwerkanalysator sieht man dann folgende Darstellung 

des Reflexionsfaktors (und dies gilt exakt, da die Kabellängen bei der Berech-

nung für eine verlustlose Leitung herausfliegen): 

 

20
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Bestimmung der Resonanzfrequenz und der Kopplung  

Im Fall der Resonanz ( 0ωΔ = ) wird die Reflexion minimal. Die Resonanzfre-

quenz 0ω  wird abgelesen, indem man mit den Cursor-Funktionen das Minimum 

des Reflexionsfaktors sucht. Die Kopplung erhält man aus 

( )
( ) ( )
( ) ( )
1 1 , 010

1 1 1 , 0

ρ ρ ρκρ ω κ
κ ρ ρ ρ

⎧ + − >− ⎪Δ = = ⇒ = ⎨+ − + <⎪⎩
 

 

wobei leider nicht zwischen 0ρ >  bzw. 0ρ <  unterschieden werden kann. Ach-

tung: Eine präzise Messung von ρ  erfordert einen kalibrierten Analysator!! 

Bestimmung der Kreisgüte  

Für die belastete Güte gilt  
2

0 0

0

1
1 2

H

H

QQ
Q

ω ωω ω κ
κ ω ω

Δ = Δ Δ +
= = ⇒ ≈

+ Δ
 

da die entsprechende Frequenzverschiebung nur die Hälfte der Halbwertsbreite 

beträgt! Wir erhalten damit für den Reflexionsfaktor 

21

( ) ( ) ( )
( ) ( )

2 2 2

2 2

1 1 12
11 1H

κ κ κρ ω
κκ κ

− + + +
Δ = =

++ + +
 

 

und damit folgende wichtige Botschaft: 

Nur im Fall κ=1 misst man zur Bestimmung der Kreisgüte die volle 3dB-

Halbwertsbreite –  dies entspricht 1 2ρ =  wegen der Leistungsdefinition 

der dB-Werte (dB = 20·log(U/U0)), in allen anderen Fällen muss bei 

( )
2 12

1H
κρ ω
κ

+
+

Δ =
1
2

≠  

die volle Halbwertsbreite bestimmt werden (vgl. die lin/log-Abbildungen)! 
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1.5 Vektorielle Messung des Reflexionsfaktors
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Eine Resonanz mit einer Kreisgüte Q0=1000 und unterschiedlichen Ankopplun-

gen (κ = 0,5; 1; 1,5) sähe in einer logarithmischen Darstellung dann folgender-

maßen aus: 

 

Vektorielle Messung des Reflexionsfaktors 

Die „Resonanzkurve“ in der komplexen Ebene  

Wir erhielten für den komplexen Reflexionsfaktor folgenden Ausdruck: 

( )
( ) ( )

( ) ( )

2
2 2

0 04i Q ωκ ω
Δ

22 2
0

2

1

1 4

4
ikl

Q

Q
e

ωκ ωρ ω
ωκ ω

−
Δ −

Δ = ⋅
Δ

− −

+ +
 

Vernachlässigen wir zunächst den Laufzeitfaktor 2ikle− und tragen den Reflexi-

onsfaktor in der komplexen Ebene auf, so beschreibt 0ρ  in der unmittelbaren 

Nähe der Resonanz einen Kreis um (x0, y0) mit dem Radius r 

0 0
1 ,x i y r

1 1
κ

κ κ
+ = − =

+ +
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Dies kann in einer länglichen Rechnung durch Einsetzen von r und x0 verifiziert 

werden, die hier nur auszugsweise zur Überprüfung wiedergegeben werden soll: 

( ) ( )
( ) ( )

( )

23

( ) ( )

2
2

2 2

0

2

0

2

2

2 2

0

2
0

1 4
1

4

11
1 4

x x

Q

Q

Q
κ

κ
ω

ω
κ

ω

κκω
κ

ω

−

+

Δ
− −

+
+Δ

+ +
+

⎢ ⎥
⎢ ⎥

⎡
⎡ ⎤
⎢ ⎥⎣

⎤
⎢ ⎥
⎢ ⎥
⎢
⎣

⎦⎥
⎦������	�����


�	


2

2 2

0 2

2

1 4

y

r
Q

ω

ω
κ

ω

Δ

Δ
+ +

=

⎡ ⎤

⎢ ⎥
⎣ ⎦����	���


 

… 

( )
( )

( ) ( )
( )

( ) ( ) ( )

2
2

2 2

0 2 2
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2 2 2
2

2 2 2 2

0
0

4
161

1

1
1 4 1 4

Q
Q

Q Q

ωκ ωω κκ κ
κωκ

ω κωκ κ
ω ω

Δ
Δ

+ −
+⇔ +
Δ +Δ+ + + +

⎡ ⎤
⎢ ⎥
⎢ ⎥
⎢ ⎥ ⎡ ⎤⎢ ⎥ ⎢ ⎥⎣ ⎦⎣ ⎦

=  

… 

( )
( )

( ) ( ) ( )

2
2

2

0

2

2 2

2 2

0

4
1

1

1
1 4 q.e.d.

Q

Q

ω
ωκ

κκκ
ω κ

κ
ω

Δ

+ +
+⇔ ⋅ =

Δ +
+ +

⎡ ⎤
⎢ ⎥
⎢ ⎥
⎢ ⎥
⎢ ⎥
⎣ ⎦

 

Radius und Position der Kreise sind also abhängig vom Koppelfaktor, hängen 

aber überhaupt nicht von der Kreisgüte ab! Unter Vernachlässigung des Lauf-

zeitfaktors gehen alle Kreise gehen durch den Punkt (-1; 0), und wir erhalten: 
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Durch den Laufzeitfaktor werden die Kreise um den Ursprung rotiert. Im Falle 

hoher Kreisgüten ist die Änderung der Kreisform durch den Laufzeitfaktor ver-

nachlässigbar und wir erhalten z.B. folgendes Bild, in dem wir den eigentlichen 

„Resonanzkreis“ und den vom Laufzeitfaktor erzeugten „Reflexionskreis“ mit 

Radius 1 erkennen: 

 
Im Fall niedriger Güten werden die Kreise durch den Laufzeitfaktor verbeult, 

und da die belastete Kreisgüte vom Koppelfaktor abhängt, ist auch die Deforma-

tion abhängig von der Kopplung; so z.B. für 0 3GHzω = , 2ml = : 
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Für eine präzise vektorielle Messung muss demnach auch hier der Analysator 
kalibriert werden - andernfalls müssten wir die Einflüsse des Laufzeitfaktors 
vernachlässigen (was wir aber nicht wollen). Generell haben solche 
Laufzeitfaktoren aber bei der Ermittlung der Kenngrößen aufgrund der hohen 
Kreisgüten einen geringen Einfluss, der im Notfall durch Verkürzen der 
Zuleitungskabel weiter verringert werden kann.
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Im Resonanzfall ist die Impedanz des Resonators reell; die Ortskurve des kom-

plexen Reflexionsfaktors muss daher die Realteil-Achse schneiden. Die entspre-

chende Frequenz ist die Resonanzfrequenz 0ω .  

 
 

Den Reflexionsfaktor in Resonanz ( 0)ρ Δω =  kann man nun wie folgt bestim-

men: Man liest sowohl den (je nach Kopplung mit einem Vorzeichen behaftete-

ten!) Abstand d des Resonanzpunktes vom Koordinatenursprung (entspricht ρ ), 

als auch den für die Normierung benötigten Radius R des Reflexionskreises 

(entspricht 1ρ = ) in Einheiten von Skalenteilen ab. Der Reflexionsfaktor ergibt 

sich dann aus dem Verhältnis der beiden Größen:  

( 0) d Rρ Δω = = .  

Der Koppelfaktor wird dann gemäß 

( ) ( )1 1= + −κ ρ ρ   
ausgerechnet.  
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Bestimmung der Resonanzfrequenz und der Kopplung  
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Bestimmung der Kreisgüte  

Für die belastete Kreisgüte gilt – völlig analog zur skalaren Messung – 
2

0 0

0

1
1 2

H

H

QQ
Q

ω ωω ω κ
κ ω ω

Δ = Δ Δ +
= = ⇒ ≈

+ Δ
 

Setzen wir dies ein, erhalten wir für den Reflexionsfaktor 

( ) ( ) ( ) ( )

27

( ) ( )

22

0 2 2/ 2
1

1

1

1
Hρ ω

κ

κ

κ

κ
±Δ =

+

− +

+

2 1iκ κ +

+

− ∓
 

woraus sich nach einem Vergleich mit Kreismittelpunkt (x0;0) und Kreisradius r 

( ) 00
1

1
/ 2H i x i rρ

1κκ
ω κ

⋅
+

= =−±Δ ∓ ∓  
+

 

ergibt. Zur Bestimmung der Halbwertsbreite wird der Resonanzkreis auf den 

Koordinatenursprung zentriert und der Frequenzvorschub beim Übergang vom 

unteren zum oberen Schnittpunkt mit der Imaginärteil-Achse gemessen. 

Aus der vektoriellen Darstellung lässt sich auch unmittelbar die unbelastete 

Kreisgüte Q0 ablesen. Setzen wir die Beziehung 0 0Q ω ω= Δ  (diesmal aber mit 

der vollen Frequenzverschiebung!) in die Formel für ρ ein, erhalten wir 

( )
( )

2

20
5

1 4
κ

κ
ρ ω −

+ +
Δ± =

( )21 4
4i κ

κ + +
 ∓

Diese Werte beschreiben in Abhängigkeit von κ einen Kreis mit Radius 

5 2r =  um den Punkt ( )0; 2i  bzw. ( )0; 2i− , was wiederum durch Einsetzen 

verifiziert werden kann, z.B. für 0 1 2y = − : 

[ ] ( )( ) ( )
2

2
2 22

2 1 5
1 45 1 4

2
4

4
κκ κ κ+ + + + = +− ⋅ +−⎡ ⎤ ⎡ ⎤⎣ ⎦⎢ ⎥⎣ ⎦

 

[ ]
4 3 2

4 2 4 3 220 110 100 25 5
10 25 4 14 20 25

4 4

κ κ κ κ
κ κ κ κ κ κ

+ + + +
⇔ − + + = ⋅ + + + +  

[ ]
4 3 2

4 3 25 20 70 100 125 5
4 14 20 25

4 4
q.e.d.κ κ κ κ

κ κ κ κ
+ + + +

⇔ = ⋅ + + + +  
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Man erhält daher die Frequenzverschiebung ωΔ  von der Resonanzfrequenz 0ω  

und damit die volle Halbwertsbreite zur Bestimmung der unbelasteten Güte aus 

dem Schnittpunkt des Resonanzkreises mit einem der erwähnten Kreise um 

( )0; 2i± . Die unbelastete Güte wird dann über 0 0Q ω ω= Δ  errechnet. 

Weitere wichtige Größen und das Smith-Diagramm  

Jede Mikrowellenleitung hat einen allgemeinen Wellenwiderstand 0Z  und ist an 

ihrem Ende mit irgendeinem Abschlusswiderstand aZ  abgeschlossen. Bei der 

Transformation des Abschlusswiderstands längs der Leitung (was sich formal 

als eine Multiplikation mit dem entsprechenden Laufzeitfaktor erweist) stellt 

sich heraus, dass dieser an ausgezeichneten Stellen reell wird. Daher geht man 

bei der Behandlung von Leitungen gerne von einem reellen Abschlusswider-

stand aus, der ggf. in die gewünschte komplexe Impedanz längs der Leitung 

transformiert werden kann. Man definiert in diesem Zusammenhang die  

Leitungsanpassung   
0

0

0
0

, für
1
1 1 , für

a
a

a
a

Z Z Z
Z

m
Z Z Z
Z

κ
ρ
ρ

κ

⎧
= <⎪

− ⎪= = ⎨+ ⎪ = >⎪
⎩

 

 

Bei der Ausbreitung von Mikrowellen treten für 0aZ Z≠  Reflexionen auf und 

folgende drei Kenngrößen sind dabei von besonderem Interesse: 

1. relativer norm. Widerstand  
0

( )
s

Z sz
Z

=  an der Stelle s der Leitung 

2. Reflexionsfaktor   0
0

0

2 21
1

s

s

i ks i ksZ Z
Z Z

e eκρ ρ
κ

− −− −
= = ⋅ = ⋅

+ +
 

3. Stehwellenverhältnis   max

min

ˆ 1 1
ˆ 1

U
S

mU
ρ
ρ

+
= = =

−
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Andere Größen können dann auf einfache Weise aus diesen berechnet werden. 

So ist zum Beispiel die im Abschlusswiderstand umgesetzte Wirkleistung  

(d.h. in unserem Fall die im Resonator dissipierte Leistung) in Abhängigkeit der 

eingespeisten Leistung : 

AP

0P

29

( ) 02
4

1a
SP P
S

= ⋅
+

 

was man durch Einsetzen von 
2

0 0
1 ˆ
2

P P U Z+ += =  und 
2

0
1 ˆ
2

P U Z− −=  in 

 erhält. aP P P+= − −

Zur Transformation der (relativen) Impedanzen längs der Leitung werden in die 

Darstellung des Reflexionsfaktors in der komplexen Ebene noch zusätzlich fol-

gende Hilfslinien aufgenommen: 

• m – Kreise:  konst. konst.m κ= ↔ =  

• Realteilkreise:  ( ) ( )0Re Re konst.s sz Z Z= =  

• Imaginärteilkreise: ( ) ( )0Im Im konst.s sz Z Z= =  

• l – „Kreise“:  2 konst.i kse− =  

Durch Einsetzen der Beziehung für den komplexen Reflexionsfaktor in die ent-

sprechenden Kreisgleichungen können folgende Kreisradien und -mittelpunkte 

leicht verifiziert werden: 

• m – Kreise:  0 0 0M x i y= + = ,   1
1

mr
m

−
=

+
 

• Realteilkreise:  ( )
( )0 0

Re
Re 1

M x i y
κ

κ
= + =

+
, 

( )
1

Re 1
r

κ
=

+
 

• Imaginärteilkreise: 
( )0 0 1

Im
iM x i y
κ

= + = + , 
( )
1

Im
r

κ
=  

• l – „Kreise“:  Geraden durch 0 0 0x i y+ =  und  1 1
2i ksi yx e−+ =
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Die so verschönerte Darstellung erhält den Namen „Smith-Diagramm“ und er-

laubt in unserem Fall ein besonders einfaches Ablesen des Koppelfaktors (als 

Berührungspunkt des Resonanzkreises mit einem Realteilkreis): 

 
Mit Hilfe dieser Darstellung lassen sich Resonanzfrequenz, Koppelfaktor, 

Kreisgüte und die Impedanz des Resonators auch unter Berücksichtigung des 

Laufzeitfaktors ermitteln. Da dies einen tieferen Einblick in mögliche Fehler-

quellen gewährt, wollen wir exemplarisch folgenden Fall betrachten 

• Resonanzfrequenz: 0 2 3GHzω π= ⋅ , 

• Unbelastete Güte: 0 500Q = , 

• Koppelfaktor:  0,6κ = , 

3029



 

Erläuterung der Messmethoden  W. Hillert 

• Leitungslänge:  ( ) 0981,25mm 9 13 16l λ= + ⋅�  

und vereinfachend davon ausgehen, dass die Wellenlänge im Kabel gleich 

der Vakuumwellenlänge ist. Auf dem Bildschirm erscheint folgendes Bild: 

 
Wir lesen aus dem Berührungspunkt mit dem m – Kreis den Koppelfaktor 

 ab (für überkritische Kopplung ist der Wert 0,6κ = 1 m  zu verwenden) und 

bestimmen die zugehörige Resonanzfrequenz 0 3GHzν =  am Frequenzgenera-

tor. Aus dem Drehwinkel des Mittelpunkts des Resonanzkreises um den Koor-

dinatenursprung erhalten wir die Leitungslänge bis auf ein Vielfaches von 2λ  

(einmal herum entspricht einem Vorschub von 2λ ); mit  ergibt sich 225ϕΔ = D

(5 8 2 mod 2l )λ λ= ⋅ . Bei der Bestimmung der Güte ist die Deformation des 
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Kreises durch den Laufzeitfaktor zu berücksichtigen. Wir zeichnen zunächst den 

idealen Resonanzkreis um den „Mittelpunkt“ des realen Resonanzkreises, 

bestimmen die Schnittpunkte auf dem Durchmesser senkrecht zur Verbindungs-

linie vom Mittelpunkt zum Ursprung und transformieren diese längs des schnei-

denden m – Kreises auf den Resonanzkreis. Dort lesen wir die jeweilige Fre-

quenzverschiebung ab und erhalten aus der zugehörigen vollen Halbwertsbreite 

die belastete Güte . 312,5Q =

Man sieht hierbei sehr schön, dass im Falle moderater Kreisgüten und langer 

Leitungen die Bestimmung von Q aus den Schnittpunkten des Durchmessers 

mit dem realen Resonanzkreis zu kleine Werte von ωΔ  liefert! 
 

Wir lernen dabei gleichzeitig, dass aus dem bei 0 2ω ω± Δ  vorliegenden m – 

Wert ( ) ein Stehwellenverhältnis 0,16m ≈ 1 6,S m 3= ≈  resultiert und wir im-

merhin noch ca. die Hälfte der Leistung in den Resonator hineinbekommen. Die 

unbelastete Güte ergibt sich zu ( )0 1 1,6 500Q Q Qκ= + ⋅ = ⋅ = . 

Aus der Verschiebung der Punkte bei 0 2ω ω± Δ  durch den Laufzeitfaktor lässt 

sich obendrein noch die die vollständige Länge des Verbindungskabels bestim-

men. Wir zeichnen die entsprechenden Verbindungsgeraden zwischen Ursprung 

und den Punkten 0 2ω ω− Δ  auf dem realen und idealen Resonanzkreis und er-

halten als Zwischenwinkel . Dies entspricht mit 11,3φΔ = D

0

0 0 0 0

4 4 4 2 12 l l l lkl
Q0

π π λ π ω πφ
λ λ λ λ ω λ

κΔ +
Δ = − Δ = − = − ⋅ = ⋅ = ⋅

Δ Δ
 

0
0 09,81

2 1
Ql φ λ λ

π κ
⋅ ≈⇔

Δ
= ⋅ ⋅

+
 

was unsere Verhältnisse recht gut trifft!  
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6. Störkörpermessungen 

Zur Messung der elektrischen und magnetischen Felder innerhalb des Resona-

tors (vorzugsweise auf der Achse) sind Antennen ungeeignet, da die erforderli-

chen Zuleitungen die Feldverteilung im Resonator stören würden. Daher wird 

durch Einbringen eines kleinen dielektrischen (bzw. leitenden) Körpers das e-

lektrische (bzw. das elektrische und das magnetische) Feld innerhalb des Reso-

nators am Ort des Körpers leicht verändert. Diese Veränderung bewirkt eine 

Verschiebung der Resonanzfrequenz ( 0ω ω→ ) und bei unveränderter Anregung 

mit 0ω  eine Veränderung des Reflexionsfaktors. Beides kann gemessen und zur 

Bestimmung der Feldstärken herangezogen werden. Im Fall der Messung der 

Verschiebung der Resonanzfrequenz spricht man von der resonanten Störkör-

permethode (da der Resonator dann weiterhin resonant angeregt wird), im Fall 

der Messung der Veränderung des Reflexionsfaktors bei unveränderter Anre-

gung von der nicht resonanten Störkörpermessung. Zur Bestimmung der 

Shuntimpedanz ist eine Messung des elektrischen Feldes ausreichend. Diese er-

folgt mithilfe eines dielektrischen Störkörpers, auf den hier vornehmlich einge-

gangen werden soll. 

Slater-Formel  

Wir unterscheiden im Folgenden zwischen den „ungestörten“ Feldern (d.h. bei 

ausgefahrenem Störkörper) 

0 0
0 0undi t i tE e H eω ω⋅ ⋅
G G

, 

die sich bei der Anregung mit der originären Resonanzfrequenz 0ω  ergeben und 

den „gestörten“ Feldern (d.h. bei eingefahrenem Störkörper) 

( ) ( )0 0 0 0undi tD e P e BE He M ei t i t i tω ω ω ω
G G GG G

ε μ= + = +⋅ ⋅ ⋅ ⋅
G

, 

die bei der veränderten Resonanzfrequenz ω  angeregt werden. Die zusätzliche 

Polarisation  und Magnetisierung P
G

M
G

 rühren vom Störkörper her. 

33

32



 

Erläuterung der Messmethoden  W. Hillert 

Wir berechnen im Folgenden die Änderung der gespeicherten Energie. Dazu 

gehen wir von den Maxwellschen Gleichungen im Resonator aus und erhalten 

im Innenraum des Resonators wegen 0, 0j ρ= =
G

 

0
0 0 0 0 0

0
0 0 0 0 0

DH D

B

i
t t

E

i
t
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i

iE B

ωH E

HE H
t

ω

ε ω ε

μ ω μ

∂ ∂
∇ × = = → ∇ × = =

∂ ∂
∂ ∂

∇ × = − = → ∇ × = − = −
∂ ∂

GG G

GG

GG G

GG

G

GG

G

G G
 

Multiplikation der ersten Gleichung mit *
0E
G

 und der zweiten mit *
0H
G

, Ausnutzen 

der Operatoridentität ( ) ( ) ( )a b a b b∇ × = ∇ × + ∇ ×
G G GG G GG Gi i i aG

(
0 0 0 0 0

0 0 0 0 0

 und Ersetzen der Rotati-

on der ungestörten Felder durch ihre zeitliche Ableitung gemäß den linken Glei-

chungen ergibt: 

( )
)

* * *

* * *

i iE H E

H Ei

D

H

H H

E E Bi

ωω μ

ω ε ω

− =

+ =

i
G G GG G

∇ ×

∇ ×

G
i i
G
i i

G G

G

GGG G  
i

Wir integrieren über den Innenraum des Resonators und erhalten durch Anwen-

dung des Gauß’schen Satzes 

( ) ( ) ( )

( ) ( ) ( )* * *i dV i

H

E E

E

VE H dBωω ε
�����

* * *
0 0 0 0 0

0 0 0 0 0

0
VV

V

V

V V

i dV i dVdA

dA

H DE H

H

ωω μ
∂

∂

×

=

=

×

−

+ =

∫∫

∫∫

∫∫∫ ∫∫∫

∫∫∫ ∫∫∫

G
i

���	��


� G

i

i i

i i

G GG G G

G

w

w

G

G GG G G
 

Das Oberflächenintegral verschwindet aufgrund der Randbedingungen auf den 

leitenden Innenwänden des Resonators. Einsetzen der gestörten Felder ergibt 

( ) ( ) ( )

( ) ( ) ( )* *

V V

dV dH V dVH MHωμ ω= − −

* * *
0 0 0 0 0 0

*
0 0 0 0 0 0

V

V V V

dV dV dVH E P

E

H E E

E

ω μ ε

ω

ω ω

ε

− = +∫∫∫ ∫∫∫ ∫∫∫

∫∫∫ ∫∫∫ ∫∫∫

i i i

i i

G G G

G G GG

G

i

G G

G G  

Wir multiplizieren die erste Gleichung mit ω , die zweite mit 0ω , subtrahieren 

beide voneinander und erhalten mit den Näherungen einer hohen Kreisgüte 

( 2
0ωω ω≈ ) und  eines kleinen Störkörpervolumens ( 2*

0E E E≈
G G
i )  
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( )*
02

0
2

000

2SV

V

E

E dVε
ω

*
02

2

dH VP M
ω ω

ωω

−
−

=
Δ

≈
∫∫∫

∫∫∫

G G
i
G G

i
 

 

Wir müssen nur noch über das Volumen  des Störkörpers integrieren, da die 

Polarisation und Magnetisierung nur innerhalb des Störkörpers von Null ver-

schieden sind. Im Nenner der so genannten Slater-Formel steht das doppelte der 

gespeicherten Energie W im Resonator, welche mittels der Beziehung zur Güte 

sowie zur Resonanzfrequenz berechnet werden kann, vgl. Kapitel 2.1 bzw. Ka-

pitel 2.3. 

SV

 

Resonante Störkörpermessung  

Im Fall eines kugelförmigen dielektrischen Störkörpers ist die Polarisation pa-

rallel und proportional zum elektrischen Feld. Hat der Störkörper eine kleine 

Dielektrizitätskonstante, kann in guter Näherung 

( )0 0 , 0P E Mε ε= − ⋅ =
G G G

 

gesetzt werden. Wir definieren die Störkörperkonstante Sα  durch 

( )0
1

2S SVα ε ε= ⋅ − ⋅  

und erhalten die elektrische Feldstärke ( )0E z  an der Stelle z auf der Achse in 

Abhängigkeit der dort gemessenen Verschiebung ( )zωΔ  der Resonanzfrequenz: 

( ) ( )
0 2

zWE z
ω

α ω
Δ

= ⋅ ⋅
0S
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Nicht resonante Störkörpermessung  

Regen wir den Resonator bei eingefahrenem Störkörper weiterhin auf der Fre-

quenz 0ω  (und damit um ωΔ  von seiner Resonanzfrequenz entfernt) an, ändert 

sich der Reflexionsfaktor. Mit den Ergüssen aus Kapitel 4 erhalten wir: 

( ) ( )
0

0
0 0

0
0

1 21,
1 1 2

iQ

iQ

ωκ ωκ ρ ωρ ω
κ ωκ ω

⎛ ⎞Δ− +⎜ ⎟− ⎠⎝= =
+ ⎛ Δ+ +⎜ ⎟

⎝ ⎠
⎞

 

Wir messen demzufolge eine Veränderung des Reflexionsfaktors von 

( )
0

0 2
0

4
1

i Qκ ωρ ρ ρ
ωκ
Δ

Δ = − ≈ ⋅
+

 

und erhalten damit unter Einbeziehung der Ergebnisse der resonanten Störkör-

permethode: 

( ) ) ( )
2

0

1
2

W

0 S

E z z
Q
κ

ρ
κ α
+

= ⋅ ⋅ Δ  

 

Bestimmung der Shuntimpedanz  

Die Shuntimpedanz SR  wurde in Kapitel 2 anhand des Ersatzschaltbildes eines 

Hohlraumresonators als Schwingkreis eingeführt. Hierdurch ergibt sich folgen-

der Zusammenhang zwischen Spannung U , Verlustleistung  und VP SR : 

2

2S
V

UR
P

=  

36

 

  

 

(Es muss warnend erwähnt werden, dass bei der Betrachtung von Linearbe-

schleunigern stets eine Definition ohne  den Faktor 2 im Nenner verwendet wird).

Die Beschleunigungsspannung  U  erhält man durch Integration des elektrischen 

Feldes  längs der Achse des Resonators:
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dz( )0
0

L

U E z= ⋅∫  

Bei der Bestimmung des Energiegewinns eines Teilchens muss zusätzlich die 

Änderung des elektrischen Feldes während der Laufzeit des Teilchens durch den 

Resonator berücksichtigt werden. Im Fall ultra-relativistischer Teilchen gilt 

, wodurch sich die Zeitabhängigkeit cv c≈ os( )tω  durch cos( )z
c

ω  ausdrücken 

lässt. Dieser Effekt wird oft in der Shuntimpedanz berücksichtigt und wir erhal-

ten dann 

( )
22

0
2

1 cos
L

S
V L

s
c

R E s ds
P

ω

−

⎛ ⎞
⎜ ⎟
⎝ ⎠

= ⋅ ⋅ ⋅∫  

 

Er lässt sich auch durch den Laufzeitfaktor Λ  ausdrücken: 

( )

( )

22

0
2

2

0
2

cos
L

L
L

L

s
c

E s d

E s ds

ω

−

−

⎛ ⎞
⎜ ⎟
⎝ ⎠

⋅ ⋅

Λ =
⋅

∫

∫

s
 

Da die Verlustleistung über die Kreisgüte mit der gespeicherten Energie ver-

knüpft ist, muss diese für die Bestimmung von SR  nicht bekannt sein. Wir erhal-

ten demzufolge: 

a)  resonante Methode:   ( )
22

0
2
0 2

2 L

S
S L

QR z dzω
ω α −

= Λ ⋅ ⋅ Δ ⋅
⋅ ∫  

b)  nicht resonante Methode:  ( ) ( )
22 2

0 2

1
2

L

S
S L

R z dz
κ

ρ
ω κα −

+
= Λ ⋅ ⋅ Δ ⋅∫  
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7. Anhang 

7.1. Feldplots einiger Resonatormoden 

Die untenstehenden Abbildungen zeigen jeweils eine Momentaufnahme der 

Verteilung der elektrischen und magnetischen Felder für die ersten Resonator-

moden (nicht nach Frequenzen geordnet), so wie sie sich aus einer Computersi-

mulation (CST Microwave Studio) ergeben. Gerechnet wurde mit einem zylind-

rischen, abgeschlossenen Hohlraum, welcher die Abmessungen der im Versuch 

verwendeten Resonatoren aufweist. Für die Abbildung wurde der Resonator o-

berhalb einer willkürlich gewählten Schnittebene transparent dargestellt. 
 

Mode Elektrisches Feld Magnetisches Feld

TM010

  

TM110
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Mode Elektrisches Feld Magnetisches Feld

TM210

TM310

TM020
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Mode Elektrisches Feld Magnetisches Feld

TM120

TM011

 

TM111
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Mode Elektrisches Feld Magnetisches Feld

TE011

TE111

TE211
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Mode Elektrisches Feld Magnetisches Feld

TE311

  

Einfluss seitlicher Öffnungen im Resonator auf die Feldverteilung  

Die im Versuch verwendeten Resonatoren weisen seitliche Öffnungen auf, wel-

che für die Störkörpermessungen benötigt werden. Im Vergleich zum geschlos-

senen Resonator ergibt sich eine andere Feldverteilung, hier am Beispiel des e-

lektrischen Feldes der TM010-Mode (wird im Versuch bestimmt) erkennbar: 

Resonator ohne Öffnungen Resonator mit Öffnungen
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2 Versuchsdurchführung

2.1 Experimenteller Aufbau

Abbildung 1: Der experimentelle Aufbau mit den wichtigsten Bestandteilen.

Der experimentelle Aufbau besteht aus (s. Abb.1):

(a) einem vektoriellen Netzwerkanalysator,

(b) einem zylindrischen Hohlraumresonator,

(c) einer Messplatform für Störkörpermessung, mit der ein dielektrischer Störkörper entlang der zen-
tralen Achse des Resonators bewegt wird, und

(d) einem Multimeter, mit dem die genaue Position des Resonators bestimmt wird.

(e) einem Kalibrierungsset.

2.2 Der Vektorielle Netzwerkanalysator

Zur Beschreibung von Hochfrequenzschaltungen werden die sogenannten Wellengrößen bevorzugt. Man
unterscheidet die hinlaufende Welle a und die rücklaufende Welle b. Die hinlaufende Welle breitet sich
vom Analysator zum Messobjekt aus. Die rücklaufende Welle bewegt sich in entgegengesetzter Richtung,
also vom Messobjekt zum Analysator. In den folgenden Abbildungen ist die hinlaufende Welle grün und
die rücklaufende Welle orange dargestellt. Die Abb.2a zeigt ein Eintor mit seinen Wellengrößen. Die zum
Eintor laufende Wirkleistung ist durch |a|2 und die vom Eintor reflektierte Wirkleistung ist durch |b|2 ge-
geben. Der Reflexionsfaktor ρ beschreibt das Verhältnis von hinlaufender zu rücklaufender Welle. Er ist
im Allgemeinen komplex und kann aus der komplexen Impedanz Z berechnet werden. Man verwendet
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(a) Eintor mit hin- und
rücklaufender Welle. (b) Zweitor mit seinen Wellengrößen.

Abbildung 2: Wellengrößen und S-Parameter

dazu die normierte Impedanz z= Z/Z0 mit der Bezugsimpedanz von typisch Z0= 50Ω. Der Reflexionsfak-
tor ρ lässt sich in der komplexen Reflexionsfaktorebene darstellen, z.B. dem Kurzschlusspunkt entspricht
ρ = −1+0 · i, dem Anpassungspunkt ρ = 0+0 · i und dem Leerlaufpunkt ρ = 1+0 · i.
Bei einem Zweitor (vgl. Abb. 2b) besteht neben der Reflexion an den beiden Toren auch die Möglichkeit
einer Transmission in Vorwärts- und Rückwärtsrichtung. Ähnlich wie zuvor der Reflexionsfaktor sind
die Streuparameter (S-Parameter) s11, s12, s21 und s22 als Verhältnisse der beteiligten Wellengrößen de-
finiert. Bei der Vorwärtsmessung wird ein reflexionsfreier Abschluss ρ = 0 am Tor 2 verwendet. Man
erzwingt damit a2 = 0. Die Erregung erfolgt am Tor 1 durch die hinlaufende Welle a1. Man misst unter
diesen Betriebsbedingungen am Tor 1 den Eingangsreflexionsfaktor s11 und zwischen Tor 1und Tor 2 den
Vorwärtstransmissionsfaktor s21:

s11 =
b1

a1

∣∣∣∣∣
a2=0
, s21 =

b2

a1

∣∣∣∣∣
a2=0

(1)

Bei der Rückwärtsmessung wird der reflexionsfreie Abschluss ρ = 0 am Tor 1 verwendet (a1 = 0). Die Er-
regung erfolgt am Tor 2 durch die hinlaufende Welle a2. Man misst unter diesen Betriebsbedingungen am
Tor 2 den Ausgangsreflexionsfaktor s22 und zwischen Tor 2 und Tor 1 den Rückwärtstransmissionsfaktor
s12:

s12 =
b1

a2

∣∣∣∣∣
a1=0
, s22 =

b2

a2

∣∣∣∣∣
a1=0

(2)

Als eine Überlagerung der beiden Messsituationen a1 = 0 bzw. a2 = 0 kann der allgemeine Betriebsfall
(a1 , 0 und a2 , 0) verstanden werden. Dies führt auf den Zusammenhang:b1

b2

 = s11 s12

s21 s22

 · a1

a2

→ b⃗ = S · a⃗ (3)

Eine der häufigsten Messaufgaben in der Hochfrequenztechnik ist die Analyse von Schaltungen (Netz-
werken). Ein Netzwerkanalysator ist dafür konzipiert, diese Aufgabe besonders exakt und effizient durch-
zuführen. Die Schaltungen, die mit Netzwerkanalysatoren untersucht werden, reichen von einfachen Bau-
teilen (z.B. Filtern, Verstärkern, ...) bis hin zu komplexen Baugruppen (z.B. Signalzüge eines Nachrich-
tensatelliten) oder auch Hohlraumresonatoren, die in Teilchenbeschleuniger eingesetzt werden können.
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Der Netzwerkanalysator erzeugt ein sinusförmiges Testsignal, das als Anregung (z.B. a) auf das Mess-
objekt gelangt. Er misst die ebenfalls sinusförmige Reaktion (z.B. b) des Messobjektes. Sie weisen im
Allgemeinen unterschiedliche Amplitude und Phase auf.
Ein skalarer Netzwerkanalysator erfasst nur den Amplitudenunterschied der Wellengrößen. Ein vektoriel-
ler Netzwerkanalysator (VNA,Vector Network Analyzer) ist wesentlich aufwändiger in der Realisierung.
Er erfasst Amplitude und Phase und ordnet ihnen einen (oder mehrere) komplexen S-Parameter zu (vgl.
Gl. 3). Der Betrag |s11| des S-Parameters s11 = b/a ≡ ρ (vgl. Kapitel 1.3) entspricht dem Amplituden-
verhältnis der Wellengrößen b und a. Die Phase des S-Parameters arg(ρ) entspricht der Phasendifferenz
der Wellengrößen.

(a) ZV-V170.

(b) Schritt 1 (c) Schritt 2 (d) Schritt 3

(e) Schritt 4

Abbildung 3: Reihenfolge der VNA Kalibrierung

2.3 VNA Kalibrierung

Jedes Messergebnis ist mit einer Messunsicherheit behaftet, welche die erwartete Streuung der Messwerte
beschreibt. Zwei Arten von Messunsicherheiten sind zu unterscheiden:

a) Messunsicherheiten hervorgerufen durch zufällige Messabweichungen. Diese Abweichungen können
nur statistisch beschrieben, aber nicht gezielt korrigiert werden.

b) Messunsicherheiten hervorgerufen durch systematische Messabweichungen. Diese Abweichungen
treten reproduzierbar auf und können daher gezielt korrigiert werden. Eine mögliche Fehlerquel-
le ist z.B. die Änderung der Temperatur während der Messung. Diese führt zu der sogenannten
thermischen Drift - die Messergebnisse werden zeitabhängig. Eine mögliche Lösung gegen die-
se thermische Störung ist eine gute thermische Stabilität der Umgebung und eine zeitliche Pause
zwischen einer Messung und dem Einschalten des Netzwerkanalysators. Ferner besitzt der Verbin-
dungskabel eine Kapazität, Induktion und einen ohmschen Widerstand, dass zu der Änderung der
Amplitude und der Phase des zurückgesendeten Signals führen kann.
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Ein Eintornetzwerkanalysator lässt sich mit einem linearen Messabweichungsmodell modellieren. Im
Rahmen dieses Modells kann der VNA in ein Fehlernetzwerk (Fehlermatrix) und einen als ideal angenom-
menen Netzwerkanalysator aufgeteilt werden. Dieses Vorgehen ist auch auf einen N-Tor-Netzwerkanalysator
übertragbar. Als Parameter des Fehlernetzwerks dienen die sogenannten Fehlerterme eik. Mit dem als
Kalibrierung bezeichneten Vorgang werden die Fehlerterme eik bestimmt. Dazu werden mit der Mess-
anordnung (Netzwerkanalysator mit montierten Messkabeln und ggf. Messfassung) der Reihe nach ver-
schiedene Kalibrierstandards, das sind Ein- und Zweitore mit bekannten Eigenschaften, gemessen. Am
häufigsten werden die folgende Kalibrierstandards verwendet: Leerlauf (0, open), Kurzschluss (S, short)
und Abschluss (M, match). Das Kalibrierverfahren gibt vor, welche der Eigenschaften der Standards be-
kannt sein müssen. Nach Abschluss der Kalibrierung berechnet der Analysator die Fehlerterme eik aus
den Messwerten der Kalibrierung und den charakteristischen Daten. Mit Hilfe der Fehlerterme können
bei den nachfolgenden Messungen die Rohmesswerte korrigiert und die S-Parameter des Messobjekts be-
rechnet werden. Die physikalische Grenzlinie zwischen dem Fehlernetzwerk und dem Messobjekt wird
als Bezugsebene bezeichnet. Die korrigierten S-Parametermesswerte beziehen sich grundsätzlich auf die-
se Ebene.
Eine geeignete Korrektur der systematischen Messabweichungen ist eine Voraussetzung für die präzise
Durchführung des Experiments. In diesem Versuch wird ein ZV-V 170 Kalibrierungsset (vgl. Abb. 3a),
mit alle drei 0, S, M Kalibrierstandards, verwendet.
Die Kalibrierung wird in der folgenden Reihenfolge durchgeführt: im Funktionsbereich ’Channel’ des
VNA drückt man die Taste ’Cal’ (vgl. Abb. 3b). Nach dem Wählen der Funktion ’Start (Manual)’ wird
nur ein Kanal ’P1’ markiert und die Art der Messung ’Refl OSM’ ausgewählt (vgl. Abb.3c). Drückt man
auf ’Next’, so erscheint ein Fenster, in dem den Typ des Kalibrierungssets ausgewählt werden kann’ (vgl.
Abb.3d). Nachdem der Befehl ’Start Cal Sweep’ gewählt wurde, soll das verwendete Kabel an einem
Ende mit dem Netzwerkanalysator und an einem anderen mit dem Kalibrierungsset am Ausgang ’Open’
verbunden sein. Drückt man auf den Knopf ’Open’ (vgl. Abb.3e), so wird die Kalibrierung durchgeführt.
Nachdem der Vorgang abgeschlossen wurde, soll das Kabel an einem anderen Ausgang (’Short’ oder
’Match’) geschraubt werden. Die entsprechende Funktion wird auf dem Bildschirm ausgewählt. Sind alle
drei Vorgänge durchgeführt, so ist die Kalibrierung abgeschlossen.

2.4 Messung des Reflexionspektrums

Das Ziel dieser Übung ist das Spektrum des Reflexionsfaktors in einem sehr breitem Frequenzbereich
zu messen, die Grundfrequenz zu bestimmen, einige Resonatormoden höherer Ordnung zu identifizieren
und deren Frequenzen abzuschätzen.
VNA-Einstellung:
Funktionsbereich Channel→Stimulus→Start Frequency→9 kHz danach
Funktionsbereich Channel→Stimulus→Stop Frequency→8.5 GHz und
Funktionsbereich Channel→Sweep→Number of Points→100 000

Funktionsbereich Trace→Scale→Autoscale Trace

Daten Exportieren: Funktionsbereich File→Trace Data→Export ASCII. Die exportierte Datei besteht
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(a) Spektrum des Reflexionsfaktors.
(b) Bestimmung der Grundfrequenz und einige mögliche
Resonatormoden höherer Ordnung.

Abbildung 4: Messung des Reflexionspektrums

aus drei ’Spalten’ - Frequenz [Hz], Re(ρ) und Im(ρ).
Auf dem Bildschirm ist nun das Spektrum zu sehen, so wie in Abb. 4a. Exportieren Sie die Daten und
bestimmen Sie:

• die Grundfrequenz f0 (vgl. Abb.4b),

• den Fehler der Grundfrequenz σ f0 ,

• den Radius a des Resonators sowie den Fehler σa.

Versuchen Sie auch einige Resonatormoden höherer Ordnung zu identifizieren. Verwenden Sie dabei die
Formel aus S. 8, 9, die Graphik aus S. 9 sowie die Tabelle aus S. 10.

2.5 Skalare Messung von |ρ|

(a) Beispiel skalare Messung von |ρ|. (b) Beispiel Datenverarbeitung.

Abbildung 5: Bestimmung von k und Q
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Das Ziel dieser Übung ist die belastete- und die unbelastete Güte Q bzw. Q0 sowie den Kopplungs-
faktor k zu bestimmen.
VNA-Einstellung:
Funktionsbereich Channel→Stimulus→Start Frequency→ f0−10 MHz,
Funktionsbereich Channel→Stimulus→Stop Frequency→ f0+10 MHz,
Funktionsbereich Channel→Sweep→Number of Points→2000,
Funktionsbereich Trace→Format→Lin Mag,
Funktionsbereich Trace→Scale→Autoscale Trace

wobei f0 die in 2.4 bestimmte Grundfrequenz ist. Auf dem Bildschirm ist nun die Resonanzkurve zu
sehen, so wie im Beispiel in Abb. 5a. Exportieren Sie die Daten und bestimmen Sie:

(i) die Kopplung k, so wie es auf S. 20 diskutiert wurde. Beachten Sie, dass es zwei möglliche Ergeb-
nisse k1 und k2 geben kann - die erste entspricht ρ( f0) < 0 und die zweite ρ( f0) > 0, d.h. k1 < 1 und
k2 > 1,

(ii) die ’Halbwertsbreite’ ∆ω (die richtige Höhe beachten! S. 20), die belastete- und die unbelastete
Güte Q bzw. Q0,

(iii) gleichzeitig k und Q0 indem Sie die gemessene |ρ(∆ω)| zu

√
(k−1)2+

4∆ω2Q2
0

ω2
0√

(k+1)2+
4∆ω2Q2

0
ω2

0

fitten, so wie im Beispiel

in Abb. 5b gezeigt.

(iv) die Fehler von k und Q0.
Hinweis: Wie in der statistischen Vorlesung besprochen, verwenden Sie im Fall (iii) die Inverse der
Matrix der doppelten partiellen Ableitungen Gi j =

1
2
∂2

∂ai∂a j
χ2(a⃗), mit a⃗ = (k,Q0). Dabei dürfen Sie

auch das auf dem Versuchs-PC vorhandene Mathematica-Skript benutzen.

2.6 Vektorielle Messung des Reflexionsfaktors

Das Ziel dieser Übung ist die belastete- und die unbelastete Güte Q bzw. Q0, den Kopplungsfaktor k sowie
Kabellänge L und die Wellenlänge im Kabel λ zu bestimmen.
VNA-Einstellung:
Funktionsbereich Channel→Stimulus→Start Frequency→ f0−100 MHz,
Funktionsbereich Channel→Stimulus→Stop Frequency→ f0+100 MHz,
Funktionsbereich Channel→Sweep→Number of Points→20000,
Funktionsbereich Trace→Format→Polar,
Funktionsbereich Trace→Scale→Autoscale Trace

wobei f0 die in 2.4 bestimmte Grundfrequenz ist. Auf dem Bildschirm ist nun die Resonanzkurve zu
sehen, so wie im Beispiel in Abb. 6a. Exportieren Sie die Daten und dann:

(a) Zentrieren Sie die Messdaten, sodass das Zentrum des Reflexionskreises sich im Koordinatenur-
sprung der Komplexen-Ebene befindet,
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(a) Beispiel vektorielle Messung von ρ.
(b) Messdaten zentriert und normiert.

(c) Bestimmung von k,Q sowie der Kabellänge L durch
Vergleich mit dem idealen Reflexionskreis.

(d) Bestimmung von k,Q sowie der Kabellänge L mittels
Regression.

Abbildung 6: Datenverarbeitung der vektoriellen Messung des Reflexionsfaktors

(b) Normieren Sie das Koordinatensystem, sodass für den Reflexionskreis |ρ| = 1 (s. Abb. 6b),

(c) Bestimmen Sie den m-Kreis mmin der dem min(|ρ|) im Resonanzkreis entspricht. Im in Abb. 6c
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gezeigten Beispiel ist das mmin = 0.11,

(d) Bestimmen Sie den Kopplungsfaktor k. Verwenden Sie dabei die Formel aus S. 26 und beachten
dass der Abstand d mit einem Vorzeichen behaftet ist,

(e) Bestimmen Sie den m-Kreis mFWHM der ρ = − 1
k+1 ∓ i k

k+1 entspricht (vgl. Formel aus S. 27). Im in
Abb. 6c gezeigten Beispiel ist das mFWHM = 0.71,

(f) Bestimmen Sie die ’Halbwertsbreite’ ∆ f d.h. den Frequenzunterschied der beiden Schnittpunkten
zwischen mFWHM und dem realen Resonanzkreis,

(g) Bestimmen Sie die belastete- und die unbelastete Güte Q = f0
∆ f bzw. Q0 = (1+k)Q. Für das Beispiel

in Abb. 6c beträgt k = 0.800±0.002, Q = 2462±20,

(h) Bestimmen Sie den Zwischenwinkel ∆ϕ zwischen Verbindungsgeraden zwischen Ursprung und
den Punkten f0 −∆ f /2 auf dem realen und idealen Resonanzkreis. Im Beispiel in Abb. 6c beträgt
∆ϕ = (4.0±0.5)◦ (vgl. S. 30,31),

(i) Bestimmen Sie die Kabellänge L1 =
∆ϕ
2πQλ0, wobei λ0 = c/ f0 die Vakuumwellenlänge ist (vgl. S.

30,31). Im gegebenen Beispiel beträgt L1 = (2.56±0.34) m.

(j) Bestimmen Sie gleichzeitig k, Q0 und Kabellänge L2 indem Sie die Messdaten zu

ρ(∆ f ) = e−
i4πL2(∆f+ f0)

c

k−1−2i∆fQ0
f0

k+1+ 2i∆fQ0
f0

fitten (vgl. S. 18). Im Beispiel in Abb. 6d ergibt dies die folgenden

Werte: k = 0.7862±0.0003, Q0 = 4924±2 und L2 = (2.2079±0.0003) m,

(k) Betrachten Sie nun die ’wahre’ Kabellänge L0 (gemessen z.B. mit einem Maßband). Vergleichen Sie
L0 und L1 bzw. L2 und schätzen Sie die Wellenlänge λ im Kabel ab. Im Beispiel in Abb. 6d beträgt
L0 = 2,0 m und somit ist λ ≈ L0

L1
λ0 ≈ 0.8λ0, d.h. die Ausbreitungsgeschwindigkeit des elektrischen

Signals beträgt 0.8c.

(l) Berechnen Sie die Fehler von k, Q, Q0, L1,2 und λ.
Hinweis: Wie in der statistischen Vorlesung besprochen, verwenden Sie im Fall (j) die Inverse der
Matrix der doppelten partiellen Ableitungen Gi j =

1
2
∂2

∂ai∂a j
χ2(a⃗), mit a⃗ = (k,Q0,L). Dabei dürfen Sie

auch das auf dem Versuchs-PC vorhandene Mathematica-Skript benutzen.

2.7 Störkörpermessung

Das Ziel dieser Übung ist sowohl die elektrische Feldverteilung E(z) auf der Resonatorachse als Funkti-
on der longitudinalen Position z mittels resonanter- und nich resonanter Störkörpermessung als auch die
Shuntimpedanz Rs und den Laufzeitfaktor Λ zu bestimmen.
VNA-Einstellung (Kalibrierung vorausgesetzt):
Funktionsbereich Channel→Stimulus→Start Frequency→ f0−10 MHz,
Funktionsbereich Channel→Stimulus→Stop Frequency→ f0+10 MHz,
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(a) Beispiel für VNA-Anzeige während der
Störkörpermessung.

(b) Beispiel: Messung von f0− f (z)
f0

.

(c) Beispiel: Messung von ∆|ρ|.
(d) Bestimmung von E(z) mittels resonanter- und nicht
resonanter Störkörpermessung.

Abbildung 7: Datenverarbeitung der Störkörpermessung.

Funktionsbereich Channel→Sweep→Number of Points→2000,
Funktionsbereich Trace→Format→Lin Mag,
Funktionsbereich Trace→Marker→Mkr1→Marker Search→Min,
Funktionsbereich Trace→Marker→Mkr1→Search Mode→Min,
Funktionsbereich Trace→Marker→Mkr1→Marker Props→Marker Format→Lin Mag,
Funktionsbereich Trace→Marker→Mkr2→Marker Search→Min,
Funktionsbereich Trace→Marker→Mkr2→Search Mode→None,
Funktionsbereich Trace→Marker→Mkr2→Marker Props→Marker Format→Lin Mag,
Funktionsbereich Trace→Scale→Autoscale Trace

Auf der Messpaltform (Abb. 1 (c)) ist eine 140 µm dünne Nylonschnur parallel zur Resonatorachse ge-
spannt. Auf die Nylonschnur ist eine Glassperle (der Störkörper) mit r =1 mm und ϵr = 2 aufgefädelt.
Das Multimeter (vgl. Abb. 1(d)) soll eingeschaltet werden und der Resonator so verschoben, dass am An-
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fang bei z = 0 cm der Abstand zum Störkörper ungefähr 3 cm beträgt. Die Resonatorposition z lässt sich
kontinuierlich mit dem eingebauten Zahnriemen einstellen. Der Resonator ist mit einem Potentiometer
mechanisch gekoppelt, sodass die Resonatorposition z linear mit dem Potenziometerwiderstand R(z) kor-
reliert: z = a ·R(z)− b. Dabei betragen a =1,225 cm

kΩ , b =1,054 cm und der Potenziometerwiderstand wird
mit dem Multimeter gemessen, d.h. die Position des Resonators ist zu jedem Zeitpunkt durch die obige
Beziehung definiert.
Die typische Anzeige auf dem VNA-Bildschirm (s. Abb. 7a) während der Störkörpermessung ist ähnlich
der skalaren Messung von |ρ|. Durch Einbringen des Störkörpers wird eine Verschiebung der Resonanzfre-
quenz ( f0→ f ) und eine Veränderung des Reflexionsfaktors |ρ0( f0)| → |ρ( f0)| bei unveränderter Anregung
f0 erwartet (vgl. S.34, 35). Die Marker M1 und M2 sind so eingestellt, dass M1 immer die verschobene
Resonanzfrequenz f und M2 den Reflexionsfaktor |ρ( f0)| zeigt. Somit wird die relative Frequnzverschie-
bung f0− f (z)

f0
sowie ∆|ρ|(z) = |ρ( f0,z)| − |ρ( f0,0)| als Funktion der Resonatorposition gemessen.

Versuchsdurchführung:

(a) Messen Sie f0− f (zi)
f0

und ∆|ρ|(zi) für zi ϵ [0,7] cm und i = 1..N, wobei N ≥ 20 und die Messpositionen
zi möglichst gleichmässig verteilt werden sollen,

(b) Stellen Sie die Messergebnisse graphisch dar (vgl. Abb. 7b und 7c),

(c) Berechnen Sie E(z) sowohl für die resonante als auch für die nichtresonante Messung und stellen
Sie die Messergebnisse graphisch dar (vgl. Abb. 7d),

(d) Berechnen Sie die Schuntimpedanz Rs,

(e) Diskutieren Sie die Messfehler der beiden Messungen,

(f) Diskutieren Sie die systematische Fehler der nichtresonanten Störkörpermessung,

(g) Berechnen Sie den Laufzeitfaktor Λs.
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